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Preface

This User Guide has been implemented by Boot & Work, S.L. working
under the name Industrial Shields.

Purpose of the manual

The information contained in this manual can be used as a reference to operating, to
functions, and to the technical data of the signal modules, power supply modules and
interface modules.

Intended Audience
This User Guide is intended for the following audience:

Persons in charge of introducing automation devices.
Persons who design automation systems.
Persons who install or connect automation devices.

Persons who manage working automation installation.

& Warnings:

e Unused pins should not be connected. Ignoring the directive may damage the
controller.

e Improper use of this product may severely damage the controller.
Refer to the controller’s User Guide regarding wiring considerations.
Before using this product, it is the responsibility of the user to read the product’s User
Guide and all accompanying documentation.

e Maintenance must be performed by qualified personnel familiarised with the
construction, operation, and hazards involved with the control.

e Maintenance should be performed with the control out of operation and disconnected
from all sources of power.

e Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.



The Ardbox Family PLCs are Open Type Controllers. It is required that you install the
Ardbox PLC in a housing, cabinet, or electric control room. Entry to the housing,
cabinet, or electric control room should be limited to authorised personnel. Failure to
follow these installation requirements could result in severe personal injury and/or
property damage. Always follow these requirements when Ardbox family PLCs.

In case of installation or maintenance of the Ardbox please follow the instructions
marked in the Installation and Maintenance section.

Do not disconnect equipment when a flammable or combustible atmosphere is
present. Disconnection of equipment when a flammable or combustible atmosphere is
present may cause a fire or explosion which could result in death, serious injury and/or
property damage.

Avertissements:

Les broches non utilisées ne doivent pas étre connectées. Ignorer la directive peut
endommager le contréleur.

Une utilisation incorrecte de ce produit peut endommager gravement le contréleur.
Reportez-vous au Guide de I'utilisateur du controleur pour les considérations de
cablage.

Avant d’utiliser ce produit, il incombe a I'utilisateur de lire le Guide de I'utilisateur du
produit et la documentation qui I'accompagne.

La maintenance doit étre effectuée par personnel qualifié familiarisé avec la
fabrication, le fonctionnement et les dangers liés au contréleur.

La maintenance doit étre effectuée avec I'équipement hors service et déconnectée de
toutes les sources d'alimentation.

Faites attention lors de I'entretien des composants sensibles a I'électricité statique. Les
recommandations du fabricant pour ces composants doivent étre suivies.

Les automates de la famille Ardbox sont des contréleurs de type ouvert. Il est
nécessaire d'installer I'automate Ardbox dans un boftier, une armoire ou une salle de
contréle électrique. L'acces au boftier, a I'armoire ou a la salle de commande
électrique doit étre limité au personnel autorisé. Le non-respect de ces exigences
d'installation peut entrainer des blessures graves et/ou des dommages matériels
importants. Respectez toujours ces exigences lors de l'installation des automates de la
famille Ardbox.

En cas d'installation ou de maintenance du Ardbox, veuillez suivre les instructions
indiquées dans la section Installation et Maintenance.

Ne débranchez pas I'équipement en présence d'une atmosphere inflammable ou
combustible. La déconnexion de I'équipement en présence d'une atmosphére
inflammable ou combustible peut provoquer un incendie ou une explosion pouvant
entrainer la mort, des blessures graves et/ou des dommages matériels.



Application Considerations and Warranty

Read and Understand this Manual

Please read and understand this manual before using the product. Please consult your
comments or questions to Industrial Shields before using the product.

Application Consideration

THE PRODUCTS CONTAINED IN THIS DOCUMENT ARE NOT SAFETY RATED.
THEY SHOULD NOT BE RELIED UPON AS A SAFETY COMPONENT OR
PROTECTIVE DEVICE FOR ENSURING SAFETY OF PERSONS, AS THEY ARE
NOT RATED OR DESIGNED FOR SUCH PURPOSES.

Please know and observe all prohibitions of use applicable to the products.

FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR PROPERTY
WITHOUT ENSURING THAT THE SYSTEM AS A WHOLE HAS BEEN DESIGNED
TO ADDRESS THE RISKS, NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS.

NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS BEFORE THEY ARE
PROPERLY RATED AND INSTALLED FOR THE INTENDED USE WITHIN THE

OVERALL EQUIPMENT OR SYSTEM.

Industrial Shields shall not be responsible for conformity with any codes, regulations or
standards that apply to the combination of products in the customer’s application or use
of the product.

The following are some examples of applications for which particular attention must be
given. This is not intended to be an exhaustive list of all possible uses of the products,
nor is it intended to imply that the uses may be suitable for the products:

e Systems, machines, and equipment that could present a risk to life or property.

e Nuclear energy control systems, combustion systems, railroad systems,
aviation systems, medical equipment, amusement machines, vehicles, safety
equipment, and installation subject to separate industry or government
regulations.

e Outdoor use, uses involving potential chemical contamination or electrical
interference, or conditions or uses not described in this document.

At the customer’s request, INDUSTRIAL SHIELDS will provide applicable third party
certification documents identifying ratings and limitations of use that apply to the
products. This information by itself is not sufficient for a complete determination of the
suitability of the products in combination with the system, machine, end product, or
other application or use.



Intended use or of Industrial Shields products

Consider the following:

Industrial Shields products should only be used for the cases of application foreseen in
the catalogue and the associated technical documentation. If third-party products and
components are used, they must have been recommended or approved by Industrial
Shields.

The correct and safe operation of the products requires that your transport, storage,
installation, assembly, operation and maintenance have been carried out in a correct It
must respect the permissible ambient conditions. You should also follow the indications
and warnings that appear in the associated documentation.

The product / system dealt with in this documentation should only be handled or
manipulated by qualified personnel for the task entrusted and observing what is
indicated in the documentation corresponding to it, particularly the safety instructions
and warnings included in it. Due to their training and experience, qualified personnel
are in a position to recognize risks resulting from the handling or manipulation of such
products / systems and to avoid possible hazards.

Disclaimers

Weights and Dimensions

Dimensions and weights are nominal and they are not used for manufacturing
purposes, even when tolerances are shown.

Performance Data

The performance data given in this manual is provided as a guide for the user in
determining suitability and does not constitute a warranty. It may represent the result of
INDUSTRIAL SHIELDS’s test conditions, and the users most correlate it to actual
application requirements. Actual performance is subject to the INDUSTRIAL SHIELDS
Warranty and Limitations of Liability.

Change in Specifications

Product specifications and accessories may be changed at any time based on
improvements and other reasons.

It is our practice to change model numbers when features are changed, or published
ratings or when significant construction changes are made. However, some
specifications of the products may be changed without any notice. When in doubt,
special numbers may be assigned to fix or establish key specifications for your
application on your request. Please consult with your INDUSTRIAL SHIELDS
representative at any time to confirm actual specifications of purchased products.



Errors and Omissions

The information in this document has been carefully checked and is believed to be
accurate; however, no responsibility is assumed for clerical, typographical, or
proofreading errors, or omissions.

The control and drive components of an Industrial Shields PLC are approved for
industrial and commercial use in industrial line supplies. Their use in public line
supplies requires a different configuration and/or additional measures. These
components may only be operated in closed housings or in higher-level control
cabinets with protective covers that are closed, and when all of the protective devices
are used. These components may only be handled by qualified and trained technical
personnel who are knowledgeable and observe all of the safety information and
instructions on the components and in the associated technical user documentation.
When carrying out a risk assessment of a machine in accordance with the EU
Machinery Directive, the machine manufacturer must consider the following residual
risks associated with the control and drive components of a PDS.

1. Unintentional movements of driven machine components during commissioning,
operation, maintenance, and repairs caused by, for example: — Hardware defects
and/or software errors in the sensors, controllers, actuators, and connection technology
- Response times of the controller and drive — Operating and/or ambient conditions not
within the scope of the specification - Condensation / conductive contamination -
Parameterization, programming, cabling, and installation errors — Use of radio devices /
cellular phones in the immediate vicinity of the controller — External influences /
damage.

2. Exceptional temperatures as well as emissions of noise, particles, or gas caused by,
for example: — Component malfunctions — Software errors — Operating and/or
ambient conditions not within the scope of the specification — External
influences / damage.

3. Hazardous shock voltages caused by, for example: - Component malfunctions -
Influence of electrostatic charging — Induction of voltages in moving motors — Operating
and/or ambient conditions not within the scope of the specification — Condensation /
conductive contamination — External influences / damage

4. Electrical, magnetic and electromagnetic fields generated in operation that can pose
a risk to people with a pacemaker, implants or metal replacement joints, etc. if they are
too close.

5. Release of environmental pollutants or emissions as a result of improper operation
of the system and/or failure to dispose of components safely and correctly.



Warranty and Limitations of Liability

Warranty

Industrial Shields’s exclusive warranty is that the products are free from defects in
materials and workmanship for a period of one year (or other period if specified) from
date of sale by Industrial Shields.

INDUSTRIAL SHIELDS MAKES NO REPRESENTATION OR WARRANTY,
EXPRESSED OR IMPLIED, REGARDING MERCHANTABILITY,
NON-INFRINGEMENT, OR FITNESS FOR PARTICULAR PURPOSE OF THE
PRODUCTS. ANY BUYER OR USER ACKNOWLEDGES THAT THE BUYER OR
USER ALONE HAS DETERMINED THAT THE PRODUCTS WILL SUITABLY MEET
THE REQUIREMENTS OF THEIR INTENDED USE. INDUSTRIAL SHIELDS
DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR IMPLIED

Limitations of Liability

INDUSTRIAL SHIELDS SHALL NOT BE RESPONSIBLE FOR SPECIAL, INDIRECT,
OR CONSEQUENTIAL DAMAGES, LOSS OF PROFITS OR COMERCIAL LOSS IN
ANY WAY CONNECTED WITH THE PRODUCTS, WHETHER SUCH CLAIM IS
BASED ON CONTRACT, WARRANTY, NEGLIGENCE, OR STRICT LIABILITY.

IN NO EVENT SHALL INDUSTRIAL SHIELDS BE RESPONSIBLE FOR WARRANTY,
REPAIR OR OTHER CLAIMS REGARDING THE PRODUCTS UNLESS INDUSTRIAL
SHIELDS’S ANALYSIS CONFIRMS THAT THE PRODUCTS WERE PROPERLY
HANDLED, STORED, INSTALLED, AND MAINTAINED AND NOT SUBJECT TO
CONTAMINATION, ABUSE, MISUSE, OR INAPPROPRIATE MODIFICATION OR
REPAIR.
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1. DALI Ardbox Family HF: General Features

Supply Voltage

24 \ce

1/Os

Digital
Analog
Relay

COMPACT PLC ARDUINO DALI ARDBOX 201/0Os Family

LOG HF PLUS

Fuse protection (2.5A)

Input Voltage 12 to 24Vdc Polarity protection
Input rated voltage 24 Vde
Rated Power 30w
| Max. 1,5A
Size 100x45x115
Clock Speed 16MHz
32KB of which 4KB are used by
Flash Memory bootloader
SRAM 2.5KB
EEPROM 1KB
Communications 12C -- USB -- RS232 -- RS485 RS485
0 to 10Vac
Input Impedance: 39K
Separated PCB ground
Rated Voltage: 10Vac
An/Dig Input 10bit
(0-10Vcce) 5 to 24Vdc
I min: 2 to 12 mA
Galvanic Isolation
Rated Voltage: 24 Vdc
* Interrupt isolated Input RARIEREIS 5 to 24Vdc
I min: 2 to 12 mA | min: 3/6 mA
HS Galvanic Isolation Se arated PCB around
(24Vce) Rated Voltage: 24Vdc P 9
0 to 10Vac
I max: 20 mA

Analog Output 8bit
(0-10Vce)

Separated PCB ground
Rated Voltage: 10Vac

Digital Isolated Output
(24Vcce)

5 to 24Vdc
I max: 70 mA
Galvanic Isolation
Diode Protected for Relay
Rated Voltage: 24Vdc

Imax 24Vdc: 410 mA

Digital Isolated Output
Relay

220V Vac
Galvanic Isolation
Diode protected for Relay

Imax: 5A

PWM lIsolated Output

5 to 24Vdc
I max: 70 mA
Galvanic Isolation

PWM lIsolated

. Diode Protected for Relay Output 8bit
8bit (24vco) Rated Voltage: 24Vdc (2'31Vcc)
Expandability 12C — RS232 — RS485 - TTL
004001001200 Analog
Reference
004001001300 Relay




2. Technical Specifications

2.1

General Specifications:

Power supply
voltage

DC power supply

12 to 24Vdc _—

Operating
voltage range

DC power supply

11.41t0254Vdc ===

Power
consumption

DC power supply

30VAC max.

External
power supply

Power supply voltage

24Vdc _—-

Power supply output
capacity

700 mA

Insulation resistance

20MQ min. at 500Vdc between the AC terminals and the protective ground
terminal.

Dielectric strength

2.300 VAC at 50/ 60 Hz for one minute with a leakage current of 10mA
max. Between all the external AC terminals and the protective earth
terminal.

Shock resistance

80m/s? in the X, Y and Z direction 2 times each.

Ambient temperature (operating)

0° to 60°C

Ambient humidity (operating)

10% to 90% (no condensation)

Ambient environment (operating)

With no corrosive gas

Ambient temperature (storage) -20° to 60°C
Power supply holding time 2ms min.
350g max.

Weight

2.2

Performance Specification:

Arduino Board

ARDUINO LEONARDO

Control method

Stored program method

1/0 control method

Combination of the cyclic scan and immediate refresh processing methods.

Programming language

Arduino IDE. Based on wiring (Wiring is an Open Source electronics platform
composed of a programming language. “similar to the C”).
http://arduino.cc/en/Tutorial/HomePage

Microcontroller ATmega32u4
Flash Memory 32KB of which 4KB are used by bootloader
Program capacity (SRAM) 2.5KB
EEPROM 1KB

10
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off.

Clock Speed 16MHz
2.3  Symbology
Table that includes all the symbology that is used in the serigraph of the DALI Ardbox Family
HF+:
Svmbol Standard No. / Standard
y Standard Title Reference No. / Symbol Meaning
Symbol Title
IEC 60417 / , . .
— Graphical symbols 5031 / Direct Incﬁcates that. the equipment '5_"
- . . suitable for direct current only;
for use on Current . . .
. to identify relevant terminals
equipment
IEC 60417 / Indicates that the equipment is
Graphical symbols . suitable for alternating current
N for use on 5032 / Alternating only; to identify relevant
) Current .
equipment terminals
IEC 60417 /
Graphical symbols 5130 / Pulse To identify the _control by which
for use on a pulse is started.
) General
equipment
IEC 60417 / To identify an earth (ground)
Graphical symbols terminal in cases where
for use on 5017/ Earth, neither the symbol 5018 nor
) Ground . - .
equipment 5019 is explicitly required.
IEC 60417 / : . .
Graphical symbols To identify the SW|tcr_1 by
. means of which the signal
for use on 5115/ Signal lamp . .
) lamp(s) is (are) switched on or
equipment

Medical Devices

CE marking indicates that a
product complies with

Directive CE Marking licable E .
93/42/EEC applicable uropean Union
regulations
ISO 7000/ . .
Graphical symbols Indlcates_a pqtentlal_ly .
for use on 0434B / hazardous situation which, if
equioment Warning symbol not avoided, could result in
quip death or serious injury
ISO 7000/
Gra?cglcl?és)/orgbols 5036 / Dangerous To indicate hazards arising
equipment Voltage from dangerous voltages

11




3. Precautions

Read this manual before attempting to use the ARDBOX 20 I/Os Family HF DALI PLUS and
follow its descriptions for reference during operation.

3.1 Arduino Board

The ARDBOX 20 I/Os Family HF DALI PLUS PLCs include Arduino Leonardo Board as controller.

3.2 Intended Audience

This manual is intended for technicians, which must have knowledge on electrical systems.

3.3 General Precautions

The user must operate Ardbox according to the performance specifications described in this
manual.

Before using ARDBOX 20 1/Os Family HF DALI PLUS under different conditions from what has
been specified in this manual or integrating ARDBOX 20 I/Os Family HF DALI PLUS to nuclear
control systems, railroad systems, aviation systems, vehicles, combustion systems, medical
equipment, amusement machines, safety equipment and other systems, machines, and
equipment that may have a serious influence on lives and property if used improperly, consult
your INDUSTRIAL SHIELDS representative. Ensure that the rating and performance
characteristics of Ardbox are sufficient for the systems, machines, and equipment, and be sure
to provide the systems, machines, and equipment double safety mechanisms. This manual
provides information for programming and operating the Ardbox.

12



4. Software interface

Industrial Shields PLC are programmed using Arduino IDE, which is a software based on the C
language. They can also be programmed directly using C but it is much easier working with
Arduino IDE as it provides lots of libraries that help in the programming.

Furthermore Industrial Shields provides boards for programming the PLCs much easier.
Basically it is not needed to define the pins and if those pins are inputs or outputs. Everything
is set up automatically if using the boards.

In order to install Industrial Shields boards, these are the steps that must be followed.
Requirements:
Arduino IDE 1.8.15 or above (better to always have the latest version).
Steps:
1. Open Arduino IDE and go to: “File -> Preferences” located in the top left corner.

Preferences X

Settings | Network

Sketrhbook location:

C:\Jsers\Albert\Documents\Arduing Browse
Editor language: English (English) ~ | (requires restart of Arduino)
Editor font size: 15

Interface scale: Automatic | 100 7 %  (requires restart of Arduino)

Show verbose output during:  [+#] compilation upload
Compiler warnings: None

[ oisplay line numbers

[JEnable Code Folding

Verify code after upload

[Juse external editor

Checl for updates on startup

Update sketrh files to new extension on save (.pde -> .ino)
Save when verifying or uploading

Additional Boards Manager URLs:  hittp://apps.industr ialshields.com/main/arduino/boards/package_industrialshields_inde: 1]
More preferences can be edited directly in the file
Ci\Users\Albert\AppData'Local\ArduinolS\preferences. bt

(dit only when Arduino is not running)

OK Cancel

2. In Additional Boards URLs write the following:

http://apps.industrialshields.com/main/arduino/boards/package industrialshields index.json

3. Press OK to save the changes.
4. Go to: Tools -> Board: ... -> Boards Manager

13
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5. Search for industrialshields.

Boards Manager b4

{ Tvpe All ~ | industrialshields

industrialshields

Boards included in this package:
ARDBOX family, M-Duino family.
Online help

More info

Close

6. Click install (selecting the latest version).

Following this steps you will be able to use now the Industrial Shields Boards:

gvoid loop()

Y v
{1 put youl

Once the Ardbox Family is selected, an extra option will appear on Tools:

- Select the correct Ardbox Family HF PLUS Board (Ardbox Analog HF+ w/HW RS-232
DALI, Ardbox Analog HF+ w/HW RS-485 DALI, Ardbox Relay HF+ w/HW RS-232 DALI or

14



Ardbox Relay HF+ w/HW RS-485 DALI) depending on your jumpers & switch
configuration.

ﬁkt“-T.’h_JlJl‘ﬂﬂB

Fivolid setup()
/i put you

H

Svoid loop()
Hoput you

Also there are some examples of programming in File -> Examples -> Ardbox DALI Family.

Furthermore there are some extra libraries that can be found in Industrial Shields github.

https://github.com/IndustrialShields/

15
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5. How to connect PLC Arduino to PC

- Connect USB port from PLC to PC.

NOTE:
Ardbox Family uses micro USB cable.

- Open Arduino IDE interface:
- Select Industrial Shields boards -> Ardbox DALI Family
- Select the correct port.

@ sketch_mar16a | Arduino 1.8.0 - =] X
File Edit Sketch Tools Help

Auto Format ctri+T
o o 0] Archive Sketch 2
sketch_mar1s  Fix Encoding & Reload v |

Serial Monitor Cl+Shift+M =
setup

Serial Plotter Ctrl+Shift+L
put vl
WiFi101 Firmware Updater
) Board: "Ardbox family” >
Industrial Shields: "Ardbox Analog” >
oid loop (I pory 5§ Serial ports
PUE ¥ GetBoard Info COM13 (Arduino L eonardo)
) Programmer: “Arcuino as ISP" >
Burn Bootloader

Ardhox family, Ardbox.

Escritorio @ Or > R A 38

16



6. How to connect PLC to power supply

- Ardbox DALI Family PLCs are 12-24Vdc supplied. IMPORTANT: The polarity IS NOT
REVERSAL!

- Make sure that the live and GND connector of the power supply match the PLC.

Make sure that the power supply mains output is not higher than 24Vdc.

— — — — — —

3 ( \

o o | F o POWER SUPPLY

Gy Vac *'-—| |

é ; = 24 vde :
; GND n_l_.l GND )
o .

Suggested power suppliers

Compact DIN rail power supply. Assembled on 35mm
DM Rail:

-12vdc f 24vdc

-2.5A

-30W

Industrial Shields power supplies provide parallel
operation, overvaltage pratection, and overcurrent
protection. There is a LED Inductor for power status, the

power supply is certified according to UL

The standard, Part 1 of IEC 61010, sets the general safety requirements for the following types
of electrical devices and their accessories, regardless of where use of the device is intended.

The equipment must be powered from an external power source in accordance with IEC
61010-1, whose output is MBTS and is limited in power according to section 9.4 of IEC 61010-1.

WARNING: Once the equipment is installed inside an electrical cabinet, the MTBS cables of the
equipment must be separated from the dangerous voltage cables.

17



7. Ardbox DALI pinout

10s Table
Analog Digital Isolated Digital Isolated Digital/Analogic
Model Reference Input Input Output Output Relay Output
ANALOG 004001001200 8 2 3 7 0
RELAY 004001001300 8 2 0 2 8

18




8. Ardbox DALI Family I/0 serigraphy

8.1 004001001200 Zone Connections
LEFT ZONE |
Ardbox Arduino .
Connector Pin Function
HO-FD
A0.6' 3 Analog Out & ] Es
A0.5' 5 Analog Out
A0.4' 6 Analog Out 003 l!
A0.3' 9 Analog Out =f 'l
A0.2' 10 Analog Out
A0.1 11 Analog Out 05 |
A0.0' 13 Analog Out S
3
Q0.9' 1 Digital Output A2
Q0.82 0 Digital Output 4
Q0.7 7 Digital Output =
Q0.6 3 PWNM/digital Output o8
Q0.5 5 PWM/digital Output 4
Q0.4 6 PWM/digital Output s
Q0.3 9 PWNM/digital Output -4
Q0.2 10 PWM/digital Output ("H]
Q0.1 11 PWM/digital Output -
Q0.0 13 PWNM/digital Output GDCon | —
(24VTon | ——
GND
GNDCOM - GND i‘
24VCOM - Power Supply

! See section 9 to enable these connections

LEFT ZONE

Switch config*

[see section & for Communications
configuration. Enabling Communications
disables some 1/0s)

Analog Outputs pins

Digital Outputs pins

Power supply connectors
(24Vdc — GND)

19



RIGHT ZONE
Arduino
Ardbox Pin .
Connector RS232 Function 1 g
HS* -
A+23 - RS485(A) #
2.3 - RS485(B) &
Y423 - RS485(Y) ¢
23 = RS485(2)
SCL-PIN32 3 SCL(12C)
SCI-PIN2? 2 SDA(I2C)
TX-PIN4 1 -
RX-PIN8 0 ,
GND - Ground
5V - 5Vout DC
RESET - RESET
SCK - SPI-SCK
NC - Not Connected
NC - Not Connected
10.9 18 Analog/Digital Input
10.8 19 |Analog/Digital Input =
10.7 20 Analog/Digital Input
10.6 21 Analog/Digital Input
10.5 22 |Analog/Digital Input ~o~e— | [06
10.4 23 | Analog/Digital Input "‘"“.,_: 105
10.3° 26 |Analog/Digital Input £ Tt 10.4
10.2° 24 | Analog/Digital Input b :&g
10.1 29 Digital Input “‘.,_1_ 01
10.0 2 Digital interrupt B
—o - | [0.0
HS*: Hardware Serial ]
SS*: Software Serial
L DNIeLdsS
EWEO is.con
|'l ‘
: -
/ - <8
:"‘. | ; ] "1
¥ "._‘ .-'I w .
3 23 3 & oo MEEE
Config switch * f I
(see section 8 for communications |I"I|]th / Output Power LED

configuration)

2See section 8 to enable these connections
3See section 9 to enable these connections

RIGHT ZOMNE

Switch config*

[see section & for Communications
configuration. Enabling Communications
disables some 1/0s)

Communication pins

Digital/Analog

Arduino Reset button

20



8.2 004001001300 Relay Zone Connections

Left Zone
LEFT ZOME
Ardbox Arduino .
Connector Pin Function
Switch config*
(see section & for Communications
configuration. Enabling Communications
NC - Not Connected disables some 1/0s)
NC - Not Connected
SCK 15 SPI-SCK
RESET - SPI-RESET
5Vdc - 5V Output
GND - GND
RX-RS-232%5 8 Serial/RS232 Communication pins
TX-RS-2324°% 4 Serial/RS232
SCL-PIN2* 2 12C/SPI SS
SDA-PIN3* 3 I12C/SPI SS
R1 10 Relay 1 Out
R2 9 Relay 2 Out
R3 6 Relay 3 Out Relay Outputs
GND - GND
24V = =
Fower supply connectors
(24Vdec — GND)

HS*: Hardware Serial
SS*: Software Serial

4 See section 8 to enable these connections
> See section 9 to enable these connections

21



| ——
Right Zone
Arduino l ggi’&
Ardbox Pin : A
Connector RS-485 Function
HD*
B- - RS485
A+ - RS485
Z-/A0.1 - RS485/ Digital Output
Y+/A0.0 - RS485/ Digital Output

R4 5 Relay 4 Out

R5 3 Relay 5 Out

10.9 23 Analog/ Digital Input 5

10.8 22 Analog/ Digital Input | B

10.7 21 Analog/ Digital Input % -

10.6 20 Analog/ Digital Input 3

10.5 19 Analog/ Digital Input i

10.4 18 Analog/ Digital Input ;.

10.3 8 Analog/ Digital Input g

10.2 4 Analog/ Digital Input ggg

10.1 12 Analog/ Digital Input ga
10.0° 2 Digital Input / Interrupt s2h

R6 7 Relay 6 Out 2% s

R7 0 Relay 7 Out i

R8 1 Relay 8 Out

RIGHT ZONE

R5-485 pins

Analog Output Pins

Relay Outputs

Digitalf Analog Input pins

Relay Qutputs

*Depending on the mode HD/FD the Y+/Z- Analog Output pins are enabled or disabled. See

section 9 to see the configurations.

Config switch *
|see section & for communications
configuration)

Input / Qutput

LR

L3

"
"
",

|

w

\TJ'
[

| s

Power LED

Arduino Reset button
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9. Switch configuration

9.1 004001001200 Analog Model General Switches Configuration

LEFT ZONE SWITCH
Communications and inputs/outputs can not work simultaneously.

LEFT ZONE OFF oN
SWITCH OFF ON
10.8 / RS-485 DE
10.8 / RS-485 DE 10.8 RS-485 DE
RS-485DE/10.8
RS-485 DE /10.8 RS-485 DE 10.8 00/ RS.485 RE
10.9 / RS-485 RE 10.9 RS-485 RE .
RS-485 RE /10.9 RS-485 RE 10.9 SDAPIN2/10.0
SDA-PIN2 / 10.0 SDA-D2 10.0 SCL-PIN3/ Q0 6
SCL-PIN3/ Q0.6 SCL-D3 Q0.6
OFF ON

6. 10.8 / RS-485 DE — If this switch is ON the RS-485 DE is activated, otherwise the 10.8 will be
activated.

5. RS-485 DE / 10.8 — If this switch is ON the 10.8 is activated, otherwise the RS-485 DE will be
activated.

Note* To work with RS-485 DE, switch number 6 at ON and number 5 at OFF.

4. 10.9 / RS-485 RE — If this switch is ON the RS-485 RE is activated, otherwise the 10.9 will be
activated.

3. RS-485 / 10.9 — If this switch is ON the 10.9 is activated, otherwise the RS-485 RE will be
activated.

Note* To work with RS-485 RE, switch number 4 at ON and number 3 at OFF.

2. SDA-D2/10.0 — If this switch is ON the 10.0 is activated, otherwise the (12C) SDA-D2 will be
activated.

1. SCL-D3/Q0.6 — If this switch is ON the Q0.6 is activated, otherwise the (12C) SCL-D3 will be
activated.
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TOP ZONE SWITCH

TOP ZONE ON OFF
SWITCH ON OFF Q0.8
RS*/ Q0.8 RS* Q0.8 RS*
Q0.8 / RS* Q0.8 RS* Q0.9
RS*/ Q0.9 RS* Q0.9 RS*
Q0.9 / RS* Q0.9 RS*

Q0.8 / RS* - If this switch is ON the RS* is activated, otherwise the Q0.8 will be activated.
RS* / Q0.8- If this switch is ON the Q0.8 is activated, otherwise the RS* will be activated.
Q0.9 / RS* - If this switch is ON the RS* is activated, otherwise the Q0.9 will be activated.
RS* / Q0.9 - If this switch is ON the Q0.8 is activated, otherwise the RS* will be activated.

P WNR

Note* RS * can be RS-485 or RS-232 depending on the jumper configuration you have
chosen. To work with RS*, switches number 1 and 3 at ON and number 4 and 2 at OFF.

RIGHT ZONE SWITCH

RIGHT ZONE - —
SWITCH ON OFF HD - FD*
HD /FD Half Duplex Full Duplex Qo6
Q0.6 DIGITAL (Q0.6) ANALOG(AO0.6) Q0.5
Q0.5 DIGITAL (Q0.5) ANALOG (A0.5) Ll
Q0.4 DIGITAL (Q0.4) ANALOG (A0.4) 00
Q0.3 DIGITAL (Q0.3) ANALOG (A0.3) 0.2
Q0.2 DIGITAL (Q0.2) ANALOG (A0.2) Q0.1
Q0.1 DIGITAL (Q0.1) ANALOG (A0.1) 0.0
Q0.0 DIGITAL (Q0.0) ANALOG (A0.0) o =

RIGHT ZONE.

1. HD/FD — Choosing between Half/Full Duplex for the RS232 or RS485 communication. In
order to use Full Duplex, it has to be considered the TOP ZONE and the JUMPER ZONE (see
section 9).

2-8. Q0.X/A0.X — The right zone configures the outputs. If the switch is set to “ON” the Q0.X
will have the behaviour of a digital output. If it is set to “OFF” it will be analog.
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9.2 004001001300 Relay Model General Switches Configuration

LEFT ZONE SWITCH
Communications and inputs/outputs can not work simultaneously.

LEFT ZONE ON OFF
SWITCH ON OFF NG
NC ] - HD - FD*
HD/FD* Half Duplex | Full Duplex R5/PIN3-SCL
R5 / PIN3-SCL R5 PIN3-SCL 10.0/PIN2-SDA
10.0 / PIN2-SDA 0.0 PIN2-SDA
RE-RS485/10.4 | RE-RS485 10.4 RE-RS46510.4
10.4 / RE-RS485 0.4 RE-RS485 i
DE-RS485/10.5
DE-RS485/10.5 DE-RS485 10.5 10 5/DE-RS485
10.5 / DE-RS485 10.5 DE-RS485 — —

1. NC — Not Connected

2. HD/FD* — Choosing between Half/Full Duplex for the RS* communication. In order to use
Full Dupley, it has to be considered the TOP ZONE and the JUMPER ZONE (see section 9).

3. R5 / PIN3-SCL — If this switch is ON the R5 is activated, otherwise the Pin3 - SCL will be
activated.

4.10.0 / PIN2-SDA - If this switch is ON the 10.0 is activated, otherwise the Pin2 - SDA will be
activated.

1. RE-RS485 / 10.4 — If this switch is ON the RE-RS485 is activated, otherwise the 10.4 will be
activated.
2. 10.4 / RE-RS485 — If this switch is ON the 10.4 is activated, otherwise the RE-RS485 will be
activated.

Note* To work with RS-485 RE, switch number 1 at ON and number 2 at OFF.

3. DE-RS485 / 10.5 — If this switch is ON the DE-RS485 is activated, otherwise the 10.5 will be
activated.

4. 10.5 / DE-RS485 — If this switch is ON the 10.5 is activated, otherwise the DE-RS485 will be

activated.

Note* To work with RS-485 DE, switch number 3 at ON and number 4 at OFF.
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9.3 004001001200 Analog RS-232 and RS-485 Switch Configuration

ANALOG TOP ZONE
SWITCH MODE
RS*/ Q0.8 ON
Q0.8 / RS* OFF
RS*/ Q0.9 ON
Q0.9 / RS* OFF

RS* TOP ZONE:

ON

OFF

Q0.8
RS*
Q0.9
RS*

In order to enable the RS* protocol the TOP ZONE must be configured as it is

shown in the table.

Having this setup, the Q0.8 & Q0.9 are disabled.

4. RS* / Q0.8 - If this switch is ON the RS* is activated, otherwise the Q0.8 will be activated.

3. Q0.8 / RS* - If this switch is ON the Q0.8 is activated. otherwise the RS* will be activated.

2.RS* / Q0.9 - If this switch is ON the RS* is activated, otherwise the Q0.9 will be activated.

1. Q0.9 / RS* - If this switch is ON the Q0.9 is activated, otherwise the RS* will be activated.

ANALOG LEFT ZONE

swron | e | hous
10.8 / RS* DE OFF ON
RS* DE /10.8 ON OFF
10.9 / RS* RE OFF ON
RS*RE/10.9 ON OFF
SDA-D2/10.0
SCL-D3/ Q0.6

RS* LEFT ZONE: In order to enable the RS* communication protocol it is necessary that the
switches of the left one are configured as it is shown in the table.

The ones married with “-” mean that they do not affect the RS* communication protocol.
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9.4 004001001300 Relay RS-232 and RS-485 Switch Configuration

RELAY TOP ZONE
SWITCH MODE
RS*/ R8 ON
R8 / RS* OFF
RS* / R7 ON
R7 /| RS* OFF

ON

RS*
R8
RS*
R7*

RS* TOP ZONE: In order to enable the RS* protocol the TOP ZONE must be configured as it is

shown in the table.

Having this setup, the R7 & R8 are disabled.

4. RS* / R8 - If this switch is ON the RS* is activated, otherwise the R8 will be activated.

3. R8 / RS* - If this switch is ON the R8 is activated. otherwise the RS* will be activated.

2. RS* / R7 - If this switch is ON the RS* is activated, otherwise the R7 will be activated.

1. R7 / RS* - If this switch is ON the R7 is activated, otherwise the RS* will be activated.

RELAY LEFT ZONE
swion | hemr | o
NC
HD/FD ON / OFF ON/OFF
R5 / PIN3-SCL
10.0 / PIN2 - SDA
RE-RS485/10.4 OFF ON
10.4 / RE-RS485 ON OFF
DE-RS485/10.5 OFF ON

10.5 / DE-RS485 ON OFF

HD/FD: Choosing between Half Duplex or Full Duplex for the RS* communication. In order to
use Full Duplex, it has to be considered the TOP ZONE and the JUMPER ZONE (see section 9).

RS* LEFT ZONE: In order to enable the RS* communication protocol it is necessary that the
switches of the left zone are configured as it is shown in the table.

The marks with “-” mean that they do not affect the RS* communication protocol.
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9.5 004001001200 Analog I2C Switch Configuration

TOP ZONE LEFT ZONE
SWITCH MODE SWITCH MODE
RS*/ Q0.8 - 10.8 / RS-485 DE -
Q0.8 / RS* - RS-485 DE /10.8 -
RS*/10.2 - 10.9 / RS-485 RE -
10.2 / RS* - RS-485 RE /10.9 -
SDA-D2/10.0 OFF
SCL-D3/ Q0.6 OFF

12C: Enable SCL and SDA connections (direct Arduino pins) with configuration switches. 10.0 and
Q0.6 will not be available. In order to implement this communication a 4.7kQ pull-up resistor is
required.

The marks with “-” mean that they do not affect the 12C communication protocol.

9.6 004001001300 Relay I12C Switch Configuration

TOP ZONE LEFT ZONE
SWITCH MODE SWITCH MODE
10.2 / RS* - NC -
RS*/10.2 - HD / FD* -
10.3/ RS* - R5/Pin 3-SCL OFF
RS*/10.3 - 10.0 / Pin 2 - SDA OFF

RE-RS485 / 104 -

10.4 / RE-RS485 -

DE-RS485/10.5 -

10.5 / DE-RS485 -

12C: Enable SCL and SDA connections (direct Arduino pins) with configuration switches. 10.0 and
R5 will not be available. In order to implement this communication a 4.7kQ pull-up resistor is
required.

The marks with “-” mean that they do not affect the 12C communication protocol.
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10.Jumper Configuration

10.1 004001001200 Analog General Jumper Configuration

JUMPER ZONE 1
LEFT RIGHT This jumper makes the choice between connecting MAX232 to pins 0,1 of
the Arduino Leonardo or with the MAX485. In order to use the R5-232
RS-485 RS-485 .
Hardware Serial protocol both RS-232 must be connected to the D1/D0. In
Do D order to use the R5-485 Hardware Serial protocol both RS-485 must be
RS-232 RS-232 connected to the D1/D0.
JUMPER ZONE 2
This jumper zone makes the choice between connecting the inputs Q0.9,
LEFT RIGHT Q0.8 to pins 4 and 8 of the Arduino Leonardo respectively, or connect the
Q0.9 Qo8 RS-232 ports to activate the Software Serial R5-232. In order to use the
o - inputs Q0.9, Q0.8 the jumper must be connected to the pins 4 and 8. 50
Q0.9 must be connected with D4 and Q0.8 must be connected to D&.
RS-232 SS RS-232 SS

*The jumpers that are not connected to the middle jumpers MUST NOT be Connected
anywhere.

11 33 i1
o0 ' t o0
R5-485 R5-232 pigital

HARDWARE HARDWARE Output
SERIAL  SERIAL 0.8

08.%
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10.2 004001001300 Relay General Jumper Configuration

JUMPER ZONE 1

LEFT RIGHT
Y+ Z-
ENABLE ENABLE
A0.0 AO0.1
JUMPER ZONE 2

LEFT RIGHT
10.2 10.3
D4 D8

RS-232 RS232
JUMPER ZONE 3
DOWN uP
RS-485 RS-485
DO D1
RS-232 RS-232

This jumper zone makes the selection between using the R5-485 Full Duplex
or the Analog Qutputs. If it is wanted to use the RS-485 Full Duplex
communication protocol the Y+ must be connected to ENABLE, and Z- also
connected to EMABLE. If it is wanted to use the Analog QOutputs, the AQ.O
must be connected to ENABLE, and AQ.1 also connected to ENABLE,

This jumper zone makes the choice between connecting the inputs Q0.9,
0.8 to pins 4 and 8 of the Arduino Leonardo respectively, or connect the
R5-232 ports to activate the Software Serial R5-232. In order to use the
inputs 0.9, Q0.8 the jumper must be connected to the pins 4 and 8. So
0.9 must be connected with D4 and Q0.8 must be connected to DS,

This jumper makes the choice between connecting MAX232 to pins 0,1 of
the Arduino Leonardo or with the MAX485, In order to use the R5-232
Hardware Serial protocol both RS-232 must be connected to the D1/D0, In
order to use the R5-485 Hardware Serial protocol both R5-485 must be
connected to the D1,/D0.

*The jumpers that are not connected to the middle jumpers MUST NOT be Connected

anywhere.

o0
HARDWARE
SERIAL
oo 11 *e 0 :

Digital RS-232
Inputs SOF TWARE
18.2 SERTAL

18.3

DUPLEX
ve | 2

.“ R5-232

HARDWARE

OeP i
o8O
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11.Hardware Serial RS-232 & RS-485 Configuration

11.1 004001001200 Analog Hardware Serial RS-485

In order to enable the Hardware Serial RS-485 the total configuration of the Ardbox Analog HF
PLUS will be:

Switch configuration:

TOP ZONE LEFT ZONE
ACTIVATED | MODE ACTIVATED MODE
SWITCH SWITCH

RS* ON DE-RS485 ON

RS* OFF DE-RS485 OFF

RS* ON RE-RS485 ON

RS* OFF RE-RS485 OFF
SDA-PIN2 /10.0 -
SCL-PIN3 / Q0.6 -

Jumper configuration:

ZONE 1 ZONE 2

RS-485 Digital

HARDMWARE Outputs
SERIAL 0.8
Qe.9

® Available communication protocols:
o Hardware Serial RS-485.
o 12C *If 12C is active 10.0 & Q0.6 are disabled
o TTL (SoftwareSerial)
o USB



11.2 004001001200 Analog Hardware Serial RS-232

In order to enable the Hardware Serial RS-232 the total configuration of the Ardbox Analog HF

PLUS will be:

Switch configuration:

TOP ZONE LEFT ZONE
ACTIVATED | MODE ACTIVATED MODE
SWITCH SWITCH
RS* ON 10.8 OFF
RS* OFF 10.8 ON
RS* ON 10.9 OFF
RS* OFF 10.9 ON
SDA-PIN2 /10.0 -
SCL-PIN3 / Q0.6 -
Jumper configuration:
ZONE 1 ZONE 2
R5-232 Digital
HARDUWARE Outputs
SERIAL Qa8
Qa.9

® Available communication protocols:

o Hardware Serial RS-232.
*If 12C is active 10.0 & Q0.6 are disabled

o 12C
o TTL
o USB

Mote: The switches of the left
zone of the RS-485 don't
interfere in the R5-232 HS. As
pins 0 & 1 are reserved for the
R5-232, the RS-485 is totally
disabled and there is no paint
on configuring these switches
as R5-485 maode
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11.3 004001001300 Relay Hardware Serial RS-485

In order to enable the Hardware Serial RS-485 the total configuration of the Ardbox Relay HF
PLUS will be:

Switch configuration:

TOP ZONE LEFT ZONE
ACTIVATED | MODE ACTIVATED MODE
SWITCH SWITCH

RS* ON NC -

RS* OFF HD /FD ON - OFF

RS* ON R5 / PIN3-SCL -

RS* OFF 10.0 / PIN2-SDA -
RE-RS485 ON
RE-RS485 OFF
DE-RS485 ON
DE-RS485 OFF

Jumper configuration:

ZONE 1 ZONE 2 ZONE 3

tt . . . J fF
HARDWAR

SERIAL
Analog Digital
Outputs Inputs
AB.B I8.2
48.1 18.3

® Available communication protocols:
o Hardware Serial RS-485.

o I2C *If 12C is active 10.0 & Q0.6 are disabled

o TTL

o USB
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11.4 004001001300 Relay Hardware Serial RS-232

In order to enable the Hardware Serial RS-232 the total configuration of the Ardbox Relay HF

PLUS will be:

Switch configuration:

TOP ZONE LEFT ZONE
ACTIVATED | MODE ACTIVATED MODE
SWITCH SWITCH
RS* OFF NC -
RS* ON HD /FD ON - OFF
RS* OFF R5 / PIN3-SCL -
RS* ON 10.0 / PIN2-SDA -
10.4 OFF
10.4 ON
10.5 OFF
10.5 ON
Jumper configuration:
ZONE 1 ZONE 2
o0 t t
1 oo
A8.1 18.2

® Available communication protocols:
o Hardware Serial RS-232.

o 12C
o TTL
o USB

*If 12C is active 10.0 & Q0.6 are disabled

ZONE 3

HARDWAR
009 .
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12.Ardbox - Arduino 1/0s 5V pins

The Ardbox has one of the Leonardo board pins available. This pin can be programmed
according to Arduino features such as I/Os operating at 5V. As the pin is directly connected to
the Arduino Leonardo board they are not as well protected as the normal inputs. The pin is
mainly meant to be used as prototyping.

Ardbox terminal Arduino pin
SCL - PIN3 3
SDA - PIN2 2

*IMPORTANT: Do not connect the pin in the chart above to voltages higher than 5V. This
terminal provides direct access to the Leonardo board.

1.1  12C pins - SDA/SCL

The 12C protocol is meant to work in a pull-up configuration. The 12C pins in the Arduino
Leonardo are not pull-up, so in order to work with the 12C an external pull-up resistor is
required. If it is meant to work as a GPIO at 5V, the switches must be set as 12C, (section 8).

These pins are not established with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used they require a pull-up or a pull-down configuration.
The Arduino board allows the pins to be set in a pull-up configuration. If not it must be
established as an external pull-up or pull-down circuit in order to correctly work with these
pins.

1.2 Pin2/Pin3

These pins are only referred to the input 10.0 and output Q0.6 for the Analog model and inputs
10.0 and R5 for the Relay model. If the switch configuration is in OFF position the pins Pin 2/Pin
3 will be available.

These pins are not established with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used, they require a pull-up or a pull-down
configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it
must be established as an external pull-up or pull-down circuit in order to correctly work with
these pins.
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13.DALI Programming Examples

13.1 How to work with DALI

DALI, or Digital Addressable Lighting Interface, is a dedicated protocol for digital lighting control
that enables the easy installation of robust, scalable and flexible lighting networks. Find how to
work with DALI here®.

In the examples the communication with an M-Duino DALI PLC is shown, but the process is
identical with the Ardbox models. Select the correct Ardbox board in the Arduino IDE while
doing any tutorial.

®https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-work-with-dali-arduino-library-and-an-industrial-plc-22
1
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14.1/0 technical details

Digital Output Waveform

27244, 0ns N Fg———————
v

DIGITALOUT

DIGITAL OUT
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PWM Waveform

PWM OUTPOLIT

]

AMNALOGOUT

ANALDG OUT
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Analog/Digital Input Turn-on

AMALDG/DIGITAL IN
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15.Typical Connections

Ferrite KIT,

Y

s,

SHIELDED CABLE E%

SHIELDED CAEBLE 0-10v
51224V omc
GND
Ferrite KITA
0

@

SHIELDED CABLE ; Dounioed e MOURNO LAYOUT: \

.7

40



o-1ov

M, |

Ferrite KITA

GND
POWER
@m 49‘ F B  oceTamacew

Ferrite KI’

=)

41



SHIELDED CABLE

ALWAYS

Ferrite KITA

SHIELDED CABLE
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&,

Ferrite KITA i

(

* See the switch

configutarion (OFF)
i | v u-1w)

SHIELDED CABLE

GND A

2124V

SHIELDED CF\BLE/ Download the MOUINO LAYOUT:
d
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16.Connector details

The connector inside the PLCs that mounts on the PCB is MC 0,5/10-G-2,5 THT — 1963502 from
Phoenix contact. MC0,5/10-G-2,5THT

For 1/O and power supply there is a FK-MC 0,5/10-ST-2,5 - 1881406 connector from Phoenix
contact. FK-MC 0,5/10-ST-2,5

Connection details:

Article reference MC 0,5/10-G-2,5
THT
Height 8,1mm
Pitch 2,5mm
Dimension 22,5mm
Pin dimensions 0,8x0,8mm
Pin spacing 2,50mm
Article reference FK-MC 0,5/10-ST-2,5
Rigid conduit section min. 0,14 mm?
Rigid conduit section max. 0,5 mm?
Flexible conduit section min. 0,14 mm?
Flexible conduit section max. 0,5 mm?
Conduit section AWG/kcmil min. 26
Conduit section AWG/kcmil max. 20
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17.ARDBOX Family Dimensions
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18.Installation and Maintenance

Notes for installation:

- The installation position should be free from the following: dust or oil smoke,
conductive dust, corrosive or flammable gas, high temperature, condensation, and
rain.

- Besides, vibration and impact also affect the PLC normal operation and shorten its
lifespan; electric shock, fire or misact also damages the product. During drilling or
wiring, prevent the metal particles or wire segments from falling into the PLC casing,
which may cause fire, fault or misact.

- After the PLC installation, clean the ventilation duct to prevent blocking, which may
cause bad ventilation, or even fire, faults or misact.

- Do not online connect, plug or unplug cables, which are apt to cause electric shock or
damage the circuit. Installation and wire connection must be firm and reliable. Poor
connection could cause misact.

- Use shielded twisted pairs for the 1/0 of high frequency signal and analog signal to
improve system IMS.

The installation environment should be free from dust, oil smoke, conductive particles,
corrosive or flammable gases, high temperature, condensation, and rain.

Besides, vibration and impact also affect the PLC normal operation and shorten its lifespan.
It is recommended to install the PLC, together with the matching switches and contactors,
in a dedicated electric cabinet and keep the cabinet ventilated. If the location has high
ambient temperature or heat generating equipment nearby, install forced convection
devices on top or sides of the cabinet to avoid over-temperature. During drilling or wiring,
prevent the metal particles or wire segments from falling into the PLC casing, which may
cause fire, fault or misact. After the PLC installation, clean the ventilation duct to prevent
blocking, which may cause bad ventilation, or even fire, faults or misact.

The only way to disconnect the equipment from the electrical network is by removing the
connectors that feed the equipment. Once installed in the electrical cabinet it is very
important to ensure the power connectors for proper operation.

Separate the ARDBOX 20 I/Os Family HF PLUS from heat, high voltage and electrical
noise:

Always separate the devices that generate high voltage and high electrical noise from the
ARDBOX 20 I/Os Family HF PLUS. When configuring the layout of the ARDBOX 20 I/Os
Family HF PLUS inside your panel, consider the heat-generating devices and locate the
electronic-type devices in the cooler areas of your cabinet. Reducing the exposure to a
high-temperature environment will extend the operating life of any electronic device.
Consider also the routing of the wiring for the devices in the electric cabinet. Avoid placing
low-voltage signal wires and communications cables in the same tray with AC power wiring
and high energy, rapidly-switched DC wiring.
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Provide adequate clearance for cooling and wiring ARDBOX 20 1/Os Family HF PLUS. Is designed
for natural convection cooling. For proper cooling, you must provide a clearance of at least 25
cm above and below the devices. Also, allow at least 25 cm of depth between the front of the
modules and the inside of the enclosure.

Notes for maintenance:

A well-planned and executed maintenance program is essential to the satisfactory operation of
solid-state electrical equipment. The kind and frequency of the maintenance operation will
vary with the kind and complexity of the equipment as well as with the nature of the operating
conditions. Maintenance recommendations of the manufacturer or appropriate product
standards should be followed.

The following factors should be considered when formulating a maintenance program:

- Maintenance must be performed by qualified personnel familiar with the construction,
operation, and hazards involved with the control.

- Maintenance should be performed with the control out of operation and disconnected
from all sources of power.

- Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.

- Ventilation passages should be kept open. If the equipment depends upon auxiliary
cooling, e.g., air, water, or oil, periodic inspection (with filter replacement when
necessary) should be made of these systems.

- The means employed for grounding or insulating the equipment from ground should
be checked to assure its integrity.

- Accumulations of dust and dirt on all parts, including on semiconductor heat sinks,
should be removed according to the manufacturer's instructions, if provided;
otherwise, the manufacturer should be consulted. Care must be taken to avoid
damaging any delicate components and to avoid displacing dust, dirt, or debris in a way
that permits it to enter or settle into parts of the control equipment.

- Enclosures should be inspected for evidence of deterioration. Accumulated dust and
dirt should be removed from the top of the enclosures before opening doors or
removing covers.

- Certain hazardous materials removed as part of maintenance or repair procedure (e.g.,
polychlorinated biphenyls (PCBs) found in some liquid filled capacitors) must be
disposed of as described in Federal regulations.

Safety rules for maintenance personnel

Consider the following steps to follow. A false manoeuvre could be the cause of an
accident or material damage.

Do not disassemble or modify the modules. This could lead to breakdowns or
malfunctions and could lead to injuries or fire.

- All types of radio communication devices, including mobile phones and personal
handy-phone systems (PHS), must be kept more than 25cm away from the PLC in all
directions. Failure to observe this precaution exposes malfunctions caused by excess
temperature.
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- Disconnect the external power supply of the system (on all phases) before connecting
or disconnecting a module. Failure to observe this precaution may cause faults or
malfunctions of the module.

- Tighten the screws of the terminal ports and the screws of the connectors within the
prescribed tightening torque. Insufficient tightening can lead to loose parts or wires
and cause malfunctions. Excessive tightening can damage the screws and / or the
module, with the risk of falling, short circuits and malfunctions.

- Before handling a module, dispose of the electrostatic charge accumulated by the
human body by touching a suitable conductive object. Failure to observe this
precaution may cause faults or malfunctions of the module.

Repair note:

If the equipment is suitable to be repaired, it must be verified that the equipment
remains in a safe state after repair.
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19.Revision Table

Revision Number Date Changes
0 30/08/2019 First implementation
1 04 /03 /2020 Second implementation
2 08 /06 /2023 Family implementation
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About Industrial Shields:

Direction: Fabrica del Pont, 1-11

Zip/Postal Code: 08272

City: Sant Fruitds de Bages (Barcelona)

Country: Spain

Telephone: (+34) 938 760 191 / (+34) 635 693 611
Mail: industrialshields@industrialshields.com
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